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I have worked for architectural firms that 
design Destination Architecture—places 
such as theme parks, restaurants, resorts, 
hospitality, hotels, and the like. The term is 
associated with places were people want to 
go. Destinations… places that draw people 
in, make them feel relaxed, make them feel 
satisfied, make them feel at home.

If you have heard me 
speak at Autodesk Uni-
versity, you may have tak-
en a class that included 
me discussing “Destina-
tion CAD.” It encapsulat-
ed my thoughts on what a 
CAD environment should 
be in an ideal world. This 
is my personal vision for 
CAD and yours may dif-
fer from mine. Every 
CAD manager has a vi-
sion for his or her en-
vironment. Some have 
it written down, some 
move in a direction that 
they have roughly for-
mulated in their minds, 
and others kind of wander around 
and wonder about what should  
be done.

I have transposed the concept of des-
tination architecture and now apply it to 
CAD environments. Destination CAD is 
an environment where people want to be. 
It creates a buzz in your industry about 
your firm. It develops a place where people 
want to work. It envelopes everything you 
do and construct in your efforts to make 
CAD work better. It is the umbrella that 
casts a shadow over all you do.

I think that major parts of destination 
CAD can and do exist in many firms, but 
there are few firms that contain all of the 
elements of the vision that I share here. I 
think all are achievable, but like the person 
who spins plates or juggles items, these el-
ements are hard to keep active all at the 

same time. Some of them are cultural is-
sues, some are people issues, and some are 
technology issues. 

As I describe this environment, I am go-
ing to use terms as if it fully existed. If des-
tination CAD were to be fully developed, it 
would look like this. I am painting a target 
to be hit, not really providing a method for 

getting there. This is a conceptual conver-
sation. We are talking about the principles 
of how a CAD shop should run.

Destination CAD starts with a solid 
standard. Users want to know what is re-
quired of them and have an easy-to-under-
stand, logical standard that provides the 
answers to the questions that they will ask 
about producing drawings.  

The CAD standard would cover the ba-
sics, dig into the areas that need address-
ing, and be complete. I have written a lot 
about standards on my blog, but it still re-
mains an area that can always be discussed 
and improved upon. In a recent survey on 
my website, I uncovered a perspective that 
38 percent of responders thought that their 
standard was just “okay” or worse. Ten per-
cent said they don’t even have a standard (I 
shudder at the thought).

The CAD standard is fully developed, 
completely defined, and consistently fol-
lowed. It is easy to read and refer to. It is 
easy to find and every user knows what’s 
in there. Every user has been trained in 
the standard. They have all been informed 
of what is required. They are expected to 
comply and management backs up the ef-

forts for compliance.
Destination CAD has 

up-to-date software. 
Most folks do not want to 
work at a firm that is three 
or four releases behind 
the industry. This does not 
mean that you can’t be on 
2007 or 2008 software, but 
you sure shouldn’t be on 
AutoCAD® Release 14. It 
also does not mean that 
you must have moved to 
the verticals. The advanced 
software such as Autodesk® 
Revit®, Autodesk Inven-
tor®, and AutoCAD® Civil 
3D® may not be suitable 
for every environment. 

The software you use should fit your needs 
and be as current as possible.

Older software makes you less produc-
tive. It does not keep you in lock step with 
others who have moved to a later release. 
It makes you translate files back and forth 
when sharing with outsiders. It does not 
provide for improvements in features. It 
does not give you access to the latest fixes.

Older CAD software keeps you stuck 
in older methods of production. New fea-
tures are introduced and you do not avail 
yourself of them. You may not be able to 
use every last feature in the newest release, 
but there will be some that could improve 
your productivity. One feature may justify 
the expenditure of upgrading.

I know that upgrading it tough.  It takes 
time and training. Newer software may 
change the user interface (like the Rib-
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bon in the newer releases) that causes 
concern about knowing where things are 
located. But I am convinced that holding 
on to older software too long makes you 
less productive.

Destination CAD has custom content 
that works. It has solidly developed tool 
palettes. It has AutoLISP functions that 
work consistently and fill in the missing 
gaps in the software. Someone is managing 
the custom tools and documenting how to 
use them. They are not left to the discre-
tion of the user to find things on the Web 
or get them from their buddies. 

There are many ways to customize your 
software and you may use a wide collection 
of them—tool palettes, custom ribbons, 
pull-down menus, VBA, Visual LISP, and 
so on. The list of options is large. A great 
CAD environment explores each of these 
and sees what might work best. In this 
environment, you create tools, document 
them, train everyone in how they are used, 
and seek new ones when needed.

Destination CAD is a learning envi-
ronment.   It would have a schedule of in-
ternal training and send people to training 
events and Autodesk University. It would 
avail itself of reseller training, online web-
casts, and more. It would encourage online 
training such as that offered through the 
AUGI Training Program (ATP). 

There is a large list of online webcasts 
that are recorded. Many resellers offer 
webinars. The environment would encour-
age learning. It always seeks new avenues 
to train and teach. Users would be helping 
other users. Managers would learn from 
those above and below them. Training as 
a cultural norm needs to exist. It is not an 
option. It is a positive environment that ac-
tually looks for opportunities to learn more 
about the tools that people use every day.

Destination CAD pushes the enve-
lope. It would encourage experimenta-
tion (but not on production files). When 
new people join the team, others would 
ask them about the firm they left and how 
they did things at their previous job. It 
would take good ideas from any direction 
and from any level within the firm. No one 
would be looked down upon for question-
ing the status quo. 

The environment would test out new 
ideas and get feedback. No one would 
throw an idea aside just because he or 
she “thought” it would not work. When 
a good idea is found, it would be talked 
out and tested. The best ones are put  
into practice.

“That is not the way we do it” is not the 
standard answer. This does not mean that 
you embrace every new method and have 
chaotic files that jump from one new idea 

to another. It means that new ideas are 
not shot down without investigation and 
the best ideas are put into practice in a 
measured way. This is a balance between 
the standard upholding a unified produc-
tion process and new ideas improving  
the standard.

Destination CAD would have a 
large tool belt. By this I mean that it 
would have a number of tools to get the 
job done. Maybe it would contain multiple 
CAD platforms and third-party software. I 
have used one CAD platform’s tools to fix 
the others. There are many tools that open, 
read, and save to DWG. I have used them 
to fix corrupted AutoCAD files.     Maybe 
it would have little utilities that get the  
job done. 

One thing is certain, my destination 
CAD environment would not look at one 
tool as being the proper tool to be used for 
everything. A hammer is not a screwdriver. 
A variety of tools are needed and this en-
vironment would encourage them. Every 
user would have access to these tools, not 
the select few. I am not saying that you buy 
a copy of everything for everyone, but that 
every user should know who to go to or 
where they could go to find the tools.

It would also limit the number of tools 
that do the same thing. Software goes 
through cycles. The best one today may be 
outdated tomorrow by another software 
product that does it better. But you should 
not swap tools every time one comes out 
with a new feature. I have seen the seesaw 
battle among software developers as they 
strive to develop the best widget of the day. 
Stick with a good tool and slowly move to 
another for the same function only after a 
few rounds of releases have proven that the 
old tool is just not going to get updated.

Destination CAD has ample support 
staff. My rule of thumb is one hour of sup-
port person for each user. So if you have 40 
users, you should have one full-time CAD 
support person. After you get up to about 
three or four staffers, you need to re-eval-
uate this rule of thumb. I have recently 
heard of firms going way beyond these ra-
tios to 60 to one or even 75 to one. 

Some of you may not have the luxury 
of multiple staff members. In times like 
these, your firm may be cutting back on 
staff. Others may never get anyone else 
hired to assist in CAD oversight. To those, 
I say enlist persons in the firm to help you 
support the tools. They may not be under 
your supervision, you may not sign their 
timecards, but you can direct a little of 
their work. They may be willing to help out 
in a pinch. A good environment has mul-
tiple “go to” people that can help.   Some 
are CAD staff and some are coworkers. 

Destination CAD values sharing. In 
a great environment users will not hoard 
information. It is shared among users 
and staff. When a new trick is learned, it 
is passed on. When a better method of 
production is developed, it is applied to  
all projects.

Employees share blog posts that they 
find. They talk to the CAD manager 
about new ideas they have. They dis-
cuss with coworkers the latest tip they 
picked up at a user group meeting. They  
share everything. 

Destination CAD doesn’t settle for 
“good enough.” There are times when 
good enough is just that—good enough. 
But this is not the default setting for this 
environment. Everyone strives to make 
things better.  All are putting their efforts 
toward improving the whole and not just 
their part.

Good – Better – Best. Never let me 
rest, until my Good is Better and my  
Better Best.

You may have heard this motto in your 
CAD travels. Or you may have heard it ap-
plied to other areas. Either way, it is the 
motto of a great CAD environment. The 
culture creates a constant state of improve-
ment. Always moving forward, always get-
ting better.

In Destination CAD, money doesn’t 
matter. A dream for most, but the finan-
cial area does not hog-tie the CAD envi-
ronment. Money is spent wisely and is con-
sidered an investment. This is something 
that either exists at a firm or does not. It 
is very hard to create or migrate toward. It 
exists before you come and after you leave. 
But the great CAD environments have an 
attitude that supports spending money on 
technology that makes sense. Well thought 
out, planned expenditures that move the 
environment toward greater productivity.

Creating or finding this kind of CAD 
environment is hard to do, but it is not im-
possible. Focused progress can help create 
the environment in which all CAD users 
will look forward to coming to work.

Mark W. Kiker is president 
of the AUGI Board of Di-
rectors. He is a National 
CAD Standards Project 
Team Member and team 
member of the National 
BIM Standard. Mark is 

general editor of BLAUGI and also publishes 
caddmanager.com, the CADD Manager’s 
journal, as well as the caddmanager.com 
blog. He is a returning faculty member at 
Autodesk University. He is currently chief 
information officer for HMC Architects in 
Ontario, California.
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Editor’s note:
Autodesk® Revit® lets designers 

work with objects that approximate 
real-world conditions. You can place 
3D walls, roofs, and floors very quickly 
to build a design “inside-out.”

Revit lets you make 3D Masses 
which are different from building ob-
jects, and use the faces of mass ob-
jects to create walls, roofs and floors 
“outside-in.”

You can also model custom 3D 
building components inside projects 
or as stand-alone components—you 
can create a curvaceous espresso bar 
service counter to fit a specific set of 
walls, a fan-top window, or an elabo-
rate chandelier.  

Up until now, the tools for 3D mod-
eling in Revit were the same whether 
you were shaping a door handle or a 
skyscraper envelope, and only the 
size differed. Starting in Revit 2010, 
the modeling techniques for creating 
components and creating masses are 
now different, with a specialized mass 
family template available for working 
outside projects. 

--Chris Fox, AUGI Revit Editor

Massing in a project
Conceptual masses are not building ob-

jects. You create them so you can use their 
shapes to make building objects, i.e., walls, 
roofs, and floors, when your requirements 
are too curved or too torqued to form reg-
ular building objects without assistance.

Tools for working with masses in the proj-
ect environment are all on the  Conceptual 
Mass panel of the Massing & Site tab on 
the ribbon. You can load pre-defined mass 
families from the Revit library by selecting 
Place Mass, or have a go at making up your 
own mass shape by clicking In-Place Mass. 
When you start a mass in a project for the 
first time, you will see a message box about 
the Show Mass visibility toggle.

I’m bad on names, but I can 
always place a face

Place Mass can be a good place to start if 
you are new to massing. You can push and 
pull on shape handles in plan and elevation 
views, and they have instance size param-
eters. You can combine mass families to 
make complex shapes.

Note: when you place a mass family, the 
default placement option is to place on a 
face. If you wish to place a mass family on a 
level (and this includes a family you might 
have created in the Conceptual Mass fam-
ily environment to load into a project), 
select the Place on Work Plane option, as 
shown in Figure 2.

Form follows sketch
If you start an In-Place Mass in a project 

so you can create a wavy roof or slanted 
wall, for example, the Model In-Place 
Mass context tab opens. This is deceptively 
simple; it contains a number of new tools 
and operations (see Figure 3).

The biggest change in Massing for 2010 
is that you no longer work in named op-
erations. There is no Extrusion, Revolve, 
Sweep, or Blend to start before you draw 
lines. You draw 2D shapes first—profiles, 

Weapons of Mass 
Construction
A look at the new Revit Conceptual 
Mass Family Environment

REVIT ARCHITECTURE

Figure 1: The starting panel for Conceptual Masses 
in a project.
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lines, splines—and use those shapes 
in combination to make 3D solid or  
void forms. 

As an example, you can draw a rectangle 
and click Create Form > Form to make an 
extruded rectangle. Two or more outlines 
separated in space make a blended or loft-
ed form, as shown in Figure 4.. An outline 
and a line in the same work plane become 
a revolved form: Revit uses the line as an 
axis automatically. An outline and line in 
perpendicular work planes become a swept 
form, with the line as the path.

When you draw connected lines they 
automatically chain for selection. You can 
Tab to select individual lines.

A new entity created for Massing is the 
Reference Point. You use Reference Points 
to make a Spline Through Points, which is 
also new this year. As with Reference Lines 
and Reference Planes, you can locate Ref-
erence Points by using dimensions that are 
driven by parameters so you can create 
spline-based mass shapes that you can flex 
by changing a specification rather than re-
drawing the geometry. That’s cool.

Speaking of parameters, you can create 
family types if desired, which will allow 
you to cycle dimensional changes. Change 
the 10th-floor setback distance and watch 
the apartment tower change shape as a 
reference plane or point relocates. It’s no 
different from changing the shape of a 
door or window, only you are working with 
mass shapes rather than panels, frames, 
and trim.

Face life on the edge
The biggest change in massing becomes 

apparent after you have made a form of 
any type. You can select surfaces or edg-
es of forms and use 3D shape handles to 
manipulate them and distort the original 
form. This push-pull capability feels simi-
lar to SketchUp. 

You can perform other manipulations to 
selected faces and edges. Divide Surface 
places a configurable grid system. You can 
expose the points and edges of a form with 
the X-Ray option. You can Add an Edge in 
the plane of the selected surface or edge, 
and the new edge can be selected and ma-
nipulated. Add Profile works perpendicu-

Figure 2: You need to select the Work Plane option on the Place Mass 
context tab to place a mass on a level.

Figure 3: Click Create Form after you draw lines, not before.

Figure 4: You can combine outlines to make subtle and complex forms quickly.

Figure 5: You can stretch any portion of a form 
along 3 axes.

http://www.augi.com
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lar to the selected face or edge 
inside the form, placing lines like 
floor edges. These lines can then 
be further selected. With a bit of 
planning, all these controls will 
allow a highly articulated shape 
to take shape relatively quickly 
from a single original form.

With all 3D modeling, starting 
with simple forms and adding oth-
er forms or voids will enable you to 
create complex shapes efficiently. 
Once you have made your mass 
forms, Finish Mass so you can start 
generating building objects.

All in the family
All these tools are available in 

the New Conceptual Mass envi-
ronment as well. Here you select 
a template (Mass.rft) and work 
in a family file that you will load 
into a project when complete.

The Revit mass family en-
vironment looks considerably 
different from a project or com-
ponent family. The file opens to 
an isometric view with an ap-
plied background color, center 
left-right and front-back refer-
ence planes, and a level visible 
(think of Autodesk Inventor® or  
Autodesk 3ds Max®).

You can use the two reference 
planes as work planes. You can 
create levels in the 3D view; one 
click per level, and each level can 
be a visible work plane. As with 
project levels, you can set the el-
evation of a new level by direct 
keyboard entry (see Figure 7).

All the tools I outlined before 
are available in the Conceptual 
Mass family environment. You can 
create forms as extrusions, blends, 
sweeps, and revolves by combin-

ing sketched profiles and independent lines. 
You can import CAD files to use the lines. 

You cannot import Revit profiles to use 
for swept, rotated, or extruded forms, 
which to my way of thinking is a lack. This 
prohibits creating a library of default pro-
file shapes without exporting them from 
Revit to CAD. Re-use is almost always 
faster and more accurate than re-drawing.

There are tools to Set and Show the 
current Workplane so you can work at any 
angle. You can assign materials and vis-
ibility conditions, as with other families. 
As with In-Project mass families, you can 
create Family Types that you can drive  
with parameters.

If your work involves building shapes 
that are not always vertical, take a look at 
the new massing tools in Revit Architec-
ture 2010. Happy massing!

 
Chris Fox is the Revit edi-
tor for AUGIWorld, and 
has written numerous ar-
ticles on Revit Architec-
ture, Revit Structure and 
Revit MEP. He has written 
Autodesk Official Training 

Courseware for Revit Architecture and Revit 
Structure. His book Introducing and Imple-
menting Revit Architecture 2009 is pub-
lished by Autodesk Press, and the 2010 re-
lease is being written now.  Chris records 
instruction videos on Revit for CADLearn-
ing. Chris recently moved from the US to 
Australia, and leads training classes in Revit 
through corporate, university and technical 
school contacts there. You can reach him at 
chris.fox@archimagecad.com. 

Figure 6: You can use any surface or edge to subdivide a form.

Figure 7: Place conceptual mass family levels with a single click. 
These levels do not translate into project files.

Figure 8: A line and a profile make a swept form. 
You can set the start and end angle using instance 
properties.

If your work involves 
building shapes that are not 
always vertical, take a look 

at the new Massing tools in 
Revit Architecture 2010.

http://www.augi.com
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Autodesk has invested significant resourc-
es in making the Autodesk® Revit® plat-
form the world’s top tool for BIM. Among 
several other key areas that have allowed 
the company to achieve this success is the 
amount of flexibility and extendibility they 
have provided to empower users to cus-
tomize Revit to suit their unique needs.

Adhering to a formula that has prov-
en to work in similar products such as  
AutoCAD® and Autodesk® Inventor®, 
the Revit team has focused its efforts on 
building and exposing a full-featured API 
and complementing it with a development 
environment that will quickly become an 
industry standard, if it isn’t already. The 
Macro Manager serves as your guide 
through this new world of automation. 

What it isn’t
There seems to be a bit of confusion as 

to exactly what function the Macro Manag-
er helps you perform. The most common 
misconception is that it’s a “Macro Action 
Recorder” of sorts, similar to what was 
introduced in AutoCAD or what can be 
found in the latest Microsoft Office Prod-
ucts. Let me clear this up for you—it is not 
an action recorder.

What it Is 
The Macro Manager, introduced in the 

Revit 2010-based vertical products (op-
tional in the 2009 releases), is an applica-
tion designed to assist you in creating and 
managing macros you develop using the 
newly introduced VSTA Development En-
vironment. From here you can launch the 
REVIT VSTA IDE, where you can add, 
edit, build, and debug your macros.

VSTA is an acronym for Visual Stu-
dio Tools for Applications. It’s a Micro-
soft technology that provides a develop-
ment environment utilizing the .NET 
framework to create macros using C# 
and/or VB.NET. VSTA is the next evo-
lution of Visual Basic for Applications 
(VBA) that is being phased out of existing  
Autodesk applications.

What are macros?
Macros are programs you develop that 

can be designed to help save you time by 
automating certain repetitive tasks. You 

can develop a macro to perform a series of 
pre-defined steps to accomplish a particu-
lar task or perform a particular function. A 
few  macro examples include:

Capitalizing all text in a project.•	
Adding a grid to your project.•	
Collect square footage information of all •	
the rooms in your structure.
Locating and extracting REVIT content •	
to external files.

Using the Macro Manager
The Macro Manager can be launched via 

the “Manage” tab as shown in Figure 1.

Upon launching the Macro Manager, 
you will be presented with the interface 
as shown in Figure 2. Clicking the “Help” 
button will open Revit’s users guide, which 
contains a wealth of information on the 

Macro Manager as well as a general over-
view (Figure 2).

The application tab will list macro mod-
ules that are available to all opened Revit 
projects and is always the first tab active 
and to the left. It’s important to mention 
here that macros created in the application 
tab are saved locally. If you send a RVT file 
to a person on another computer, these 
macros will not be available to them.

The active document tab (Project1.rvt in 
this example) represents the project cur-
rently active in Revit and is indicated ac-
tive with a light-bulb icon. Macros created 
in the active document tab for that project 
are stored in the RVT file and will be avail-
able to any other person on any other com-
puter accessing the RVT file.

For project level macros, Revit is actu-
ally storing the code inside of the RVT file 
but temporarily extracts it to your hard 
drive when you open the RVT file at the 
following location:

“C:\Program Files\Autodesk Revit Ar-
chitecture 2010\Program\VstaMacros\Do-
cHookups\”

Creating your first macro
Before you create a macro you must 

create a Module to contain it. Modules as-
sist you in grouping your macros and are 

Figure 1: Accessing the Macro Manager

Figure 2: The Macro Manager
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listed under their parent module in the  
macro manager.

To create a new module at the applica-
tion level, select the “Application” tab and 
click “Module” under the “Create” section. 
The “Create a New Module” dialog will 
appear and allow you to enter the name 
of the module (no spaces), your program-
ming language of choice, and a description 
of your module as shown in Figure 3.

After we create the module we can then 
begin to create macros inside of our new 
module. The information we must provide 
for a new macro is similar to that of a new 
module with one exception—in place of 
the programming language selection is an 
option for the module to which the macro 
will belong. It will then inherit the pro-
gramming language of that module; refer 
to Figure 4.

Once you click OK, REVIT will launch 
the VSTA development environment and 
we are ready to write our first line of code:

    Public Sub Macro1()
        MsgBox(“Hello BIM World”)
    End Sub

Next we must “Build” and “Save” our 
macro. Select “Build” from the drop-down 

menu and click “Build My-
FirstModule.” Assuming we 
don’t get any errors, we can 
then click Save (or SaveAll) 
and close out the VSTA IDE.

We should now be back 
at the Macro Manager 
where can select our new 
macro named “Macro1” and  
click Run.

Revit will 
now close 
the Macro Manager and 
run our code, in this case 
simply displaying a dialog 
box that reads “Hello BIM 
World.”

There are  a few im-
portant items to note 
here. Revit will not run 
any new code you enter 
into the editor until you 
have successfully “Built” 
and saved your code. If 
you simply exit the editor 
without performing these 
functions, the status icon 
next to the module name 
will display an error icon 
which can mean a num-
ber of things. Please refer 
to the user’s guide for a 
complete rundown of the 

different macro states. 
Building your code allows the IDE to 

compile your code and troubleshoot it. It 
also creates the code files necessary for  
Revit to load and run. Any errors that oc-
cur during the build process will be listed 
in the VSTA IDE’s Error List.

Sharing macros
When you create application level mac-

ros as we did in the previous 
example, they are stored lo-
cally on your computer in 
the following directory :

“C:\Program Files\Autodesk 
Revit Architecture 2010\
Program\VSTAMacros\Ap-
pHookup”

In the example used in 
Figure 2, we will find two 
directories whose names 
correspond to the names of 
the modules inside of the 

“AppHookup” directory.
To share these macros with other Revit 

2010 users, simply copy the folders and 
paste them to the same location on  the 
second computer. When others access the 
Macro Manager, it will now list the new 
module and macros.

Surface scratching
Obviously we haven’t even scratched the 

surface of all the capabilities exposed to us 
though the Revit API.

Here are a few links that will help you 
as you begin your journey into the world 
of programming and dive further into the 
Revit VSTA IDE :

Revit Users Guide :
Press F1 - Search for Macro

Revit 2010 SDK :
http://images.autodesk.com/adsk/files/re-
vit2010sdk.exe

The Building Coder/Jeremy Tammik:
http://thebuildingcoder.typepad.com/

DevTV: Introduction to Revit Pro-
gramming:
http://download.autodesk.com/media/adn/
DevTV_Introduction_to_Revit_Program-
ming/

AUGI Revit API Discussion Group: 
http://forums.augi.com/forumdisplay.
php?f=218

Autodesk Revit API Discussion Group: 
http://discussion.autodesk.com/forum.
jspa?forumID=160 and of course my blog:

http://blog.cadkicks.com

Jose Guia is a Senior Application Engineer. 
Jose has a decade of experience in Auto-
CAD customization using LISP and, more 
recently, VB.NET. His years of experience in 
programming and automation have led Jose 
to develop numerous enterprise-level engi-
neering applications, databases, and custom 
windows applications.

Figure 3: Creating a module

Figure 4: Creating a macro

Figure 5: Macro directories
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Regardless of your industry, there are 
many third-party tools that can help in all 
aspects of drawing quality. For users of  
AutoCAD® Architecture, one of the tools 
is Google SketchUp. In this article, we will 
explore some basic tools in Google Sketch-
Up and you can see for yourself how user-
friendly this application is!

What is Google SketchUp?
SketchUp allows architects and civil en-

gineers to create, edit, and share 3D mod-
els. SketchUp drawings can be exported to 
AutoCAD Architecture very easily. 

There are two versions of SketchUp: 
SketchUp Pro and a free, downloadable ver-
sion that is limited in its use. The free down-
load includes integrated tools for use in up-
loading to Google Earth. The remainder of 
this article will discuss SketchUp Pro.

SketchUp is part of the same product 
family as Google Earth. With this tool, you 
can import a scaled aerial photograph from 
Google Earth to SketchUp with the click 
of a button. This can include topographical 
information as well. 

New to SketchUp?
When using SketchUp for the first time, 

you may notice a small difference in the 
navigation system. By going to the Help 
menu and selecting Quick Reference 
Card, you can print a PDF showing some 
helpful shortcuts. 

Here are a few helpful tips to help you 
get started. When using your mouse, the 
left button is for tool operations and the 
right button is for the context menu. The 
middle button (wheel) has several func-
tions: click and drag to orbit, shift click 
and drag to pan, double click to re-center 
your view, and scroll to zoom. The space-
bar operates the Select Tool. You can use 
ctrl spacebar to add to a selection set, shift 
spacebar to toggle in and out of a selec-
tion set, ctrl A to select all and shift ctrl to 
subtract from a selection set. Please print 

and read the Quick Reference Card before 
proceeding to use SketchUp.

Compatible file formats
One of the many great features of 

Google SketchUp is that it supports a 
wide variety of file formats, including 
DWG, DXF, OBJ, and WRL. If you don’t 
want to take the time to import a file into  
AutoCAD Architecture, you can also cre-
ate a screenshot of the file and save it in 
BMP, JPG, PDF, EPS, and TIF formats 
for presentation purposes. 

Importing an AutoCAD 
Architecture file into 
SketchUp

Now that we’ve looked at a few ba-
sic features 
of SketchUp, 
let’s try import-
ing a file from 
AutoCAD Ar-
chitecture into 
SketchUp. Let 
me assure you 
that it is easy. 
Begin by open-
ing SketchUp 
and select the 
File menu. Next 
select Import. 
Under the Pre-
view area, you 
will see an Op-
tions button. 
Select Options 
and then select the options that you need 
in the dialog box that opens. Click OK. See 
Figure 1, the import dialog box. Now you 
will need to select the file that you wish to 
import and click open. You have now suc-
cessfully imported a drawing into Google 
SketchUp! It is important to note that the 
SketchUp file will have the same 0,0 origin 
as your AutoCAD Architecture drawing.

Creating walls
Now that you have a drawing imported 

into Google SketchUp, let’s say that the walls 
are in 2D and you want to make them 3D in 
SketchUp. Well, here’s how you do that.

Begin by right-clicking and selecting 
Make Group. Then select the Line tool 
and select any corner of the perimeter to 
start the line. Now, enter the wall height 
in the Measurements Box and press enter. 
Next select the Rectangle tool. Begin your 
rectangle by selecting the endpoint of the 
line you just drew and end the rectangle at 
a point on the wall. Continue until all exte-
rior walls are erected. I have found that it’s 
easier to complete the exterior first. Now 
that all exterior walls have been erected 
and closed, you have created a Face. 

The Face is used to build the roof, once 
you are ready to do so. Next, select the 
Face and select the Offset tool and enter 
the thickness for the exterior walls you 
have just created. Now select the Face 
and use the Push/Pull tool. Push the Face 
down to create the interior Face of the 
walls. This will develop the interior face of 
the exterior walls so that you can continue 

A Boost from 
Google SketchUp 

Figure 1: The Import dialog box in Google SketchUp.

http://www.augi.com
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to create the interior walls at this point us-
ing the steps above.

Adding doors and windows
At this point, you have walls created. 

Now you will need to decide on header 
heights, door and window sizes, and styles 
before continuing. 

Once you are ready, be sure you are in 
X-ray mode. Now insert the door compo-
nent you selected and place it by referenc-
ing a point on an opening in your imported  
AutoCAD Architecture file. Continue plac-
ing all door components using X-ray mode. 

Next place all windows using the same 
method stated above for door placement. 
For example, if you were placing a window 
component above an overhead door, you 
would reference a point on the window 
and a point on the door. 

Exporting a SketchUp file 
into AutoCAD Architecture

Just as importing a drawing into 
SketchUp is virtually effortless, exporting 
a Google SketchUp file into AutoCAD  
Architecture is equally easy. 

Once you are ready to export, select the 
File menu and select Export. Next select 
2D Graphic or 3D Model, depending on 
the file you are exporting. Select the export 
file type from the dropdown. Since we are 
exporting to AutoCAD Architecture, you 
would select AutoCAD DWG. By select-
ing the Options button at the bottom, you 
can choose the AutoCAD version to which 
you are exporting as well as the draw-
ing scale and size. Select OK and then  
select Export. 

The export is now complete! It is impor-
tant to note that you can alternate between 
AutoCAD Architecture and SketchUp 
multiple times. Your drawing does not have 

to be complete before importing it 
into SketchUp or from SketchUp 
into AutoCAD Architecture.

3D Warehouse
A great feature of SketchUp is 

the 3D Warehouse, which allows 
you to search for 3D models made 
by other users as well as contribute 
3D models of your own. It con-
tains 3D models of buildings, cars, 
bridges, interior furnishings, and  
much more. 

A new feature allows you to 
search for similarly shaped models 
instead of relying on a text search. 
This really saves time when you’re 
in a hurry to find a specific item. 
The 3D Warehouse is a wealth of 
information and can help you de-
sign quickly when facing a tough 
deadline. Best of all, this feature is 
free for use by everyone! 

Layout tool
SketchUp contains a vast library of 

colors, textures, shadows, lighting, and 
more. You are limited only by your imagi-
nation when completing renderings in  
SketchUp. Rendering tools and materials 
libraries in AutoCAD Architecture, com-
bined with the tools in SketchUp, can pro-

duce awesome presen-
tation renderings! 

To use the library, se-
lect the File menu and 
select Send To Layout. 
This will open Layout. 
Layout 2 is a feature 
that’s included with 
SketchUp Pro and is 
used for creating and 
sharing presentations 
made from Sketch-
Up. You can add title 
blocks, save templates, 
add graphics, and cre-
ate multi-page docu-
ments. Layout gives you 
more control over color, 
style, and weight of the 
lines and faces in your 
SketchUp model.

That’s a wrap!
Google SketchUp has many capabilities 

for great quality presentation drawings. 
What we have covered in this article is 
just the tip of the iceberg. Now it’s your 
turn. Download the free version, give it a 
try, and see how you like it! There is noth-
ing better than going to a meeting with 
awesome drawings that took only minutes  
to complete.

Need more SketchUp training? 
SketchUp’s Getting Started application 
includes self-paced tutorials that will in-
troduce you to many tools, techniques,  
and procedures.

Melinda Heavrin is a CAD 
Coordinator for Norton 
Healthcare in Louisville, 
Kentucky. She can be 
reached for comments and 
questions at melindaheavr-
in@alltel.net.

Figure 2: The Export dialog box

Figure 3: Google SketchUp’s 3D Warehouse feature.

Figure 4: Layout tools

Figure 5: Layout rendering.
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Autodesk 
Impression: 
a “First Party” 
Application
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This issue of AUGIWorld focuses on ex-
tensions and third-party applications that 
complement Autodesk products. Most 
of us have used third-party apps to get 
our work done (sometimes without even 
realizing it!).   The software in which the 
third-party product is running is the “first-
party” application.   I believe that makes 
the user the second party.  It seems we like  
to party!  

Impression is not extensible
According to my “informants” at  

Autodesk, there are no third-party appli-
cations for Impression. That is because 
Impression is not extensible. Extensibility 
in a program is that program’s ability to be 
“extended” beyond its programming.  That 
means it has the ability to run programs 
within it. AutoCAD, for example, is exten-
sible; it can run other software inside it, 
such as routines created in LISP or VBA 
to name a few.

 When it is run along with AutoCAD 
(or other Autodesk products), Impres-
sion is a first-party application.   It was 
created by Autodesk, the company that  
produces AutoCAD. 

When Impression is run by itself, it 
is still a first-party application.   Impres-
sion does not run inside of AutoCAD or 
any other Autodesk product, but it does 
use data created by them.   AutoCAD 
2008 features an Impression toolbar that 
made it easy to export files to Impres-
sion. Clicking the Impression button 
in AutoCAD 2008 automatically opens  
Impression and imports your file into a new  

Impression file.  It might have had a third-
party “feel” to it, but Impression never ran 
within AutoCAD.  

AutoCAD 2010 continues with the  
Impression button. In fact, Impression has 
its own panel, called the Export to Impres-
sion panel. It can be found in the Output 
Tab. AutoCAD 2008 had it in a toolbar and 
AutoCAD 2009 has it in the Ribbon, just 
like it is in AutoCAD 2010.

Starting Impression from 
AutoCAD

Since Impression is not extensible, 
but can be invoked from AutoCAD and 
other AutoCAD-based products such as  
AutoCAD Civil3D, it can feel like a third 
party application, even though it’s not. 

There are several ways to start a new 

file to use in  
Impression. You 
can open Impres-
sion and import 
the geometry 
or you can start 
it from inside  
AutoCAD. As we 
discussed above, 
go to the Output 

Tab, then to the Export to Impression Pan-
el. This panel is present on the both the 
2D and 3D workspaces out of the box with  
AutoCAD. If you are using the menu bar 
(I know, change is difficult) then you can 
find the Export to Impression command 
under the FILE menu option. It appears 
that AutoCAD 2010 does not include a 
toolbar for Impression, but the Impres-
sion command has a button in the stan-
dard toolbar. Regardless of your current 
workspace, you can always type IMPRES-
SION on the command line. The resulting 
window looks different than the one that 
is produced from the Ribbon panel, but it 
has the same functionality.

Export settings
There are three main settings that can 

control the way 
AutoCAD ex-
ports your file to 
Impression. They 
are: What to ex-
port, Plot style 
table (for pen 
a s s i g n m e n t s ) , 
and Stroke type. 
If you have used 
AutoCAD be-
fore, then these 
three settings 
should not give 
you any trouble. 
That’s the beauty 

Figure 1: AutoCAD 2010 has an Export to Impression Panel in the Ribbon in the 
Output Tab.

Figure 2: Invoking the Impression command 
through the toolbar, menu bar option, or com-
mand brings up this interactive window that works 
similarly to the Export to Impression Panel.

Figure 3: There are many options to choose from 
when exporting geometry from AutoCAD to 
Impression.
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if Impression—it runs similarly to Auto-
CAD. If you haven’t used it yet, this simi-
larity will be comforting to you if you are 
an AutoCAD user.

What to export
Impression gives you great control over 

what geometry you use from AutoCAD. 
There are essentially four options from 
which to choose. The DISPLAY option will 
export the view you are currently showing 
(or displaying). It can be in either paper or 
model space. 

The next export setting is EXTENTS. 
This option will export all of the objects 

present in the current tab. This may work 
better in a paper space tab than in model 
space, depending on what you have in that 
tab and your method of working. 

The third option is WINDOW. This may 
be the option used most often as you can 
specify specific areas to export. Once you 
choose this option and it starts, then pick 
your window. Once your windowed area 
has been selected, an icon will appear in 
the Impression Panel next to the What to 
Export setting that indicates you have se-
lected a windowed area to export. If you 
want to change that window area, select 
this new icon. You will be asked to pick 

your new points. If you are using the Im-
pression command (not the ribbon panel) 
a preview of your export area will be dis-
played in a window to the right. 

The fourth and final option of what to 
export is Paper Space Tabs. When you 
click on the What to Export button, your 
options are displayed. At the bottom of 
those options is a list of the available tabs 
in your current drawing. You can select any 
of them to be exported even if you are not 
currently in that tab.

Plot style table setting
This option is much simpler than the 

others. If you or your company use a spe-
cific pen table when plotting, use that one. 
If not, then use the one you typically use 
when you plot. Or you can always choose 
the NONE option, which may be better 
because you are going to use the style con-
trols in Impression anyway. If you don’t 
have any set styles to use in Impression, 
then perhaps you want to use a pen table. 
This will apply styles to your geometry au-
tomatically, thus saving you some effort.

Stroke type
The third and final setting to cali-

brate when exporting to Impression from  
AutoCAD is the stroke type setting. This 
setting allows you to apply a basic stroke 
type to the geometry you are exporting be-
fore you even start working in Impression. 
This can be a huge time saver. 

There are several stroke types from 
which to choose. Their names are rather 
self- explanatory, too: Wiggle Pencil Heavy, 
Wiggle Pencil, Brown Pencil, Pencil Hard, 
Pencil Soft, Pen Wiggle Heavy, and Pen 
Wiggle Slight. It would be nice if there 
was a NONE option for this, but you do 
have to pick one. Even if you don’t want 
to use any of these stroke types in your  
Impression file, that’s okay. Autodesk Im-
pression 3 makes it very easy to quickly 
apply a different stroke type once you get 
your geometry imported.

Figure 4: Note the Window Selection Icon that is displayed indicating that you are exporting to a selected 
area.  Also see the preview of the geometry to be exported on the right.

Figure 5:  You can pick a specific tab to be exported.

While Impression is 
not extensible, you 
can get content  
from third-party 
suppliers to  
enhance  
your  
drawings.

http://www.augi.com
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Content for Impression
While Impression is not extensible, you 

can get content from third-party suppli-
ers to enhance your drawings. There are 
companies that have created and devel-
oped blocks specifically for Impression. 
There are also online communities where 
Impression users share content they have 

created. The Autodesk Impression online 
community is a great resource for content. 
You can find it at this link: http://impres-
sion.autodesk.com/

Being an Autodesk product,  
Impression can handle any DWG or DWF 
file as a block. Just link to the files you want 
through the Block Library. If you have 

gotten your hands on a block library for  
AutoCAD, you can use it in Impression, 
too. Blocks and other forms of content are 
not third-party applications, per se, but 
they do quite a bit to enhance your Im-
pression tool set.

Brian C. Benton is a CAD 
technician and designer 
based in Fort Myers, Flori-
da. Brian has been work-
ing with AutoCAD since 
release 10 in the mechani-
cal, structural, and civil 

engineering fields. He has been a detailer, 
drafter, designer, IT assistant, CAD software 
manager, protector of standards, and pro-
verbial “Help Desk.” He can be reached at 
benton.brian@gmail.com.

Figure 6:  You have a choice of seven different stroke types that can be applied directly to your geometry 
when exporting to Impression.
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http://impression.autodesk.com/
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The world of technology is an ever-changing landscape of the 
old and new. Often, a technology can become so popular and 
widely used that it tends to be well past its prime when a newer 
technology comes along. Now, there isn’t anything wrong with 
using old technology unless, that is, the technology is no longer 
supported. 

You might be wondering what this has to do with AutoCAD®. 
Well, if you have installed AutoCAD 2010, you might have no-
ticed that we are at a crossroads of sorts with Visual Basic for Ap-
plications (VBA).

With AutoCAD 2010, Autodesk has started transitioning away 
from VBA (the old) to VSTA and .NET (the new). While you can 
still create and run your VBA projects from previous releases, you 
cannot do this “out of the box.” In order to enable VBA, you must 
visit http://www.autodesk.com/vba-download and download the 
proper VBA module for the version of Windows you are running.

Does this mean that you should start to panic if you are us-
ing VBA? Not at all. VBA is still available for you to use, but you 
should start considering a move to the .NET API. While the .NET 
API takes a bit of getting used to, it is much more powerful and 
allows you to create commands and AutoLISP functions which 
cannot be done with the ActiveX API and VBA. In this 
article, I cannot cover everything you need to know in 
order to make the leap to .NET, but I’ll show you how 
to get started.

What do I need and how much is it 
going to cost me?

To get started with the .NET API, you’ll need a copy 
of Microsoft Visual Studio. Visual Studio is a develop-
ment platform that allows you to create applications 
using the .NET Framework. It is available in multiple 
versions, most of which you must pay for. Thanks to 
those great folks at Microsoft, you can get started us-
ing a free version known as Visual Studio Express.

Yes, Visual Studio Express is free, but it does lack 
some features that the other versions offer. You can 
get more information about the different versions of 
Visual Studio by visiting http://www.microsoft.com/
visualstudio/. The other versions of Visual Studio start 
off at $299. For this article, I used Microsoft Visual 
Basic 2008 Express Edition because it is similar to 
VBA and is free for you to download and use.

To install Microsoft Visual Basic 2008 Express Edition, do the 
following:
1.	Open your Internet browser and browse to http://www.micro-

soft.com/express/download/.
2.	Scroll down to the Microsoft Visual Basic 2008 Express Edi-

tion, select a language, and click Download.
3.	Follow the on screen instructions that are provided.

Creating your first project
Before you can start writing code to create a command, you 

need to first create a new project. To create a new project that al-
lows you to create an add-on for AutoCAD, do the following:
1.	Start Microsoft Visual Basic 2008 Express Edition by clicking 

Start menu > All Programs > Microsoft Visual Basic 2008 Ex-
press Edition.

2.	Once Microsoft Visual Basic 2008 Express Edition is started, 
click File menu > New Project.

3.	In the New Project dialog box (see Figure 1), select Class Li-
brary and enter a name for the new project in the Name text 
box. Click OK.

Making the 
Leap to .NET

Figure 1: New Project dialog box

http://www.augi.com
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http://www.microsoft.com/express/download/
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Visual Basic, meet AutoCAD; AutoCAD, 
meet Visual Basic

You won’t see Visual Basic hanging out with AutoCAD at the 
next Super Bowl party, but you do need to introduce the two 
to each other so Visual Basic knows about the objects in the  
AutoCAD .NET API. To inform Visual Basic about AutoCAD, do 
the following:
1.	With your new project created, click Project menu > Add Ref-

erences.
2.	In the Add Reference dialog box (see Figure 2), Browse 

tab, browse to C:\Program Files\AutoCAD 2010 (or where  
AutoCAD is installed). Press and hold Ctrl, and select the files 
acmgd.dll and acdbmdg.dll. Click OK.

Creating your first command
Now that you have formally introduced Visual Basic to  

AutoCAD, it is time to get them working together. In order to 
do this, you will have to add some information to your project 
in the form of namespaces before you can create any commands 
or actually work with the AutoCAD-related classes. Namespaces 
are used to organize the different classes that are a part of the  
AutoCAD .NET API. Add the following text above the default 
line of code Public Class Class1 in the code window:

Imports Autodesk.AutoCAD.ApplicationServices
Imports Autodesk.AutoCAD.Runtime

With the references to some of the namespaces, add to your 
project you can create a new command. Add the following lines of 

code between the lines Public Class Class1 and End Class.
‘ Create a new custom command

<CommandMethod(“MyFirstCmd”)> _
Public Sub MyFirstCmd()
  Dim acCurDoc As Document
  acCurDoc = Application.DocumentManager.MdiActiveDocument

  acCurDoc.Editor.WriteMessage(vbLf & _
    “Hello from VB .NET and AutoCAD”)
End Sub

The code you entered creates a command named My-
FirstCmd and displays the text “Hello from VB .NET 
and AutoCAD” at the command line when the command 
is used. Not very original or useful, but you have to start 
somewhere! After you have added the code, you should 
save it by clicking File menu > Save All. In the Save Proj-
ect dialog box, change the name of the project and solution 
if you want to, and specify a new location for the project if 
desired. Click Save.

Building your first assembly and 
loading it into AutoCAD

Now that you have some code and presuming it has 
been entered correctly, it is time to 
compile the project and load it into  
AutoCAD. One of the main differences 
between working in VBA and working 
with .NET is that the project needs to 
be compiled (built) before it can be used 
in AutoCAD, whereas with VBA you can 
start using it right away as long as the 
project is loaded.

Before building your project, you need 
to change a few settings that control if 
the DLLs referenced to your project are 
copied when it is built. Typically you do 
not want to copy these referenced DLLs. 
To avoid it, click Project menu > proj-
ect_name Properties. On the Properties 
tab, click the References tab. Hold down 
the Ctrl key and select acdbmgd and ac-
mgd. Then in the Properties pane (on 
the right by default), click Copy Local 
and select False from the drop-down list 
(see Figure 3). Save your project again.

Now that your project is saved and 
configured, click Build menu > Build 
project_name.  Microsoft Visual Basic 
starts the build process and should gen-

Figure 2: Add Reference dialog box

Figure 3: Project properties
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erate a file that is the same name as your 
project and a file extension of DLL in a fold-
er named Bin. If the build is successful, the 
text “Build succeeded” should be displayed 
in the lower-left corner of the status bar of 
the Microsoft Visual Basic 2008 Express 
Edition application window.

In AutoCAD, do the following to load the 
project and execute the MyFirstCmd com-
mand that you authored.
1.	At the Command prompt enter netload 

and press Enter.
2.	In the Choose .NET Assembly dialog box 

(see Figure 4), browse to the location of 
the assembly you built. By default, your 
projects will be found under a folder 
named Visual Studio 2008 in your My 
Documents folder. For example, C:\Us-
ers\user_name\Documents\Visual Studio 
2008\Projects\project_name\ project_
name \bin\Release.

3.	From the Release folder, select the file 
with the same name as your project and 
the DLL file extension. Click Open (see 
Figure 4).

4.	At the Command prompt, enter myfirstcmd and press Enter.
The text “Hello from VB .NET and AutoCAD” is displayed in 

the Command Line window.

Conclusion
While there is no official timeline as to when VBA will no lon-

ger be available in AutoCAD, it will eventually be removed com-
pletely from the product. The .NET API offers many benefits 
over the ActiveX API and VBA that you will want to start learning 
it now if you currently using VBA. While there will definitely be 
a learning curve to the .NET API, you can leverage your exist-
ing understanding of VBA. When you first start working with the 

.NET API, make sure to start writing basic routines before trying 
to tackle something large and complex. A good place to start is to 
rewrite an existing VBA project  that you are using.

Lee Ambrosius is a Sr. Technical Writer in the PSEB 
division at Autodesk, Inc. and works on AutoCAD 
and AutoCAD LT. He is the author of two Auto-
CAD books under the For Dummies series, Auto-
CAD 2009 & AutoCAD LT 2009 All-in-One Desk 
Reference For Dummies and AutoCAD 2008 3D 
Modeling Workbook For Dummies. Lee can be 

reached via e-mail at lee_ambrosius@hyperpics.com; other contact 
information can be found on his Website at http://www.hyperpics.
com or his Blog at http://hyperpics.blogs.com.

Figure 4 – Choose .NET Assembly dialog box

.NET
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Heating and 
Cooling Load 
Analysis in  
Revit MEP 2010

In studying AutoCAD® MEP and  
Autodesk® Revit® MEP, I have discovered 
a fundamental difference in philosophy be-
tween the two software packages. AutoCAD 
MEP is the definition of BIM software even 
if it isn’t marketed as such. It has a Building, 
it contains Information, and in its designed 
application it is a Model.  It is also capable 
of exporting and organizing its data in ways 
that can be useful to the engineer and third-
party software applications. 

Revit MEP is marketed the same way 
in a Revit environment, but I see it as be-
ing more! Revit MEP is becoming Build-
ing Analysis and Documentation software 
based on a BIM model.

In Revit MEP 2010, a tool has been 
added into the functionality of the base 
software: Heating and Cooling Load Anal-
ysis. This feature introduces us to the next 
generation of available design tools within 
a virtual environment—built-in analysis 
during the design process.

The architectural model
The first step in analyzing building per-

formance is acquiring the Revit architec-
tural building model, ideally from the ar-
chitects. I’d recommend creating this in a 
version of Revit Architecture that matches 

the version of Revit MEP that you are us-
ing (example: each created in Revit 2010). 
By doing this, the interoperability between 
the architects and engineers will be maxi-
mized should changes in the architec-
tural design take place. A traditional 2D 
architectural model created in AutoCAD 
will not work within Revit MEP with-
out a lot of conversion/tracing inside the  
Revit environment. 

A model originally done in AutoCAD 
Architecture (3D) can potentially be used 
if it is IFC exported to Revit, but it likely 
will take a fair amount of cleanup to be 
made usable for accurate analysis. 

Ultimately, neither of these “AutoCAD” 
methods are recommended unless you are 
prepared to do a lot more work on your 
end and are willing to accept an increased 
chance of coordination mistakes. An accu-
rate model is vital as it will be used as the 
basis for the rest of the analytical calcula-
tions we will be performing.  

Spaces and zones
The Spaces and Zone tools will be our 

next step.  Spaces are used as data stor-
age and calculation areas for each of the 
areas/rooms in which they are placed. In-
formation such as supply airflow, HVAC 

load, ceiling and wall lighting reflectance, 
and volume are contained within Spaces.  
Spaces may also contain occupancy loads, 
ventilation information, and even the name 
of the Space, which can automatically be 
generated by the name of the Room in the 
architectural model. In short, Spaces are 
the information storage areas of the Revit 
MEP model, much like Rooms are in the 
architectural model.  

Zones are much like Spaces; in fact,  
they are made up of Spaces grouped into 
Zone categories. Zones can also be sched-
uled and take some of their information 
from the Spaces that created them.

Without going into a “how-to” on Space 
and Zone creation, it is sufficient to say 
that these are the objects that have made 
a complete architectural BIM model vi-
tal. Spaces “expand” out to find the walls, 
roofs, and ceilings, which are the bind-
ing elements of the model. If a space 
has multiple angles and ceiling heights, 
a space can accommodate these condi-
tion changes. If these binding architec-
tural elements should move and/or be 
adjusted, then these spaces will adjust and 
their quantity and space information will  
adjust accordingly.

http://www.augi.com
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Building performance
Our building performance calculations 

will be based off the volumes of the spac-
es and zones inside the building. To start 
the calculations, go to the Analyze tab on 
the ribbon in Revit MEP 2010 and select 
Heating and Cooling Loads.

On the left-hand side of the Heating and 
Cooling Loads dialog (see Figure 1) you 
will notice the building model, complete 
with the zones that you have input into the 
model. You have the same controls in this 
model as you do in the traditional Revit 
environment. Click in the white “model” 
area, then select different spots on the 
View Cube in order to spin the model and 
view your building and spaces more easily. 
The traditional “Shift+Wheel” spin works 
as well. Affecting the look of this display is 
the button that is easily overlooked in the 
lower, left-hand corner below the display 
area. This button will change the visual 
representation between Wireframe and 
Shading modes.

On the right side of the Loads dialog, 
you will notice your “General” project in-
formation under the General tab. This in-
cludes the ability to specify:

Building Type
Project Location
Building Services
Building Construction
Building Infiltration Class
Report Type
Ground Plane
Project Phase
Sliver Space Tolerance

The next tab is the Details tab. This con-
tains information related to our spaces and 
zones as well as Analytical Surfaces.  You 

will find each Zone/Space can have its own 
set of supporting data. Simply select the 
appropriate zone or space on the list and 
you’ll be able to read its supporting data 
on the list below.

Notice the Highlight and Isolate buttons 
that are available on the right side of the 
Spaces/Zones list. By selecting these, Revit 
will highlight and/or isolate that zone on the 
model. This is a great feature to be able to 
find the appropriate space on your model. 
The Analytical Surfaces area (selected next 
to Spaces under the Details tab) is similar 
in function except that it shows every sur-
face that will be taken into account during 
these calculations and during export of the 
model into third-party applications.

Calculate the report
When we finish setting up our spaces 

with the appropriate information, we hit 
the “Calculate” button in the Heating 
and Cooling Loads dialog box to create 
our building analysis report. This report 
will be generated via the IES software 
that comes with Revit MEP.  The report 
is based on not only the appropriate Lati-
tude and Longitude information, but also 
the information in the physical model and 
appropriate weather information specified 
within the project data. 

The weather information is now ac-
cessed by retrieving the monthly data from 
the closest weather station to that area to 
ensure greater accuracy or it can still be 
manually input into the software for spe-
cial conditions.  

Figure 1: Heating and cooling loads

Figure 2: The Details tab includes Space, Zone, and 
Analytical Surface Information.

This is a 
feature that 
introduces us 
to the next 
generation 
of available 
design 
tools within 
a virtual 
environment, 
built-in 
analysis 
during 
the design 
process
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Checksums and summaries
This report offers building summaries 

and also breaks these calculations down to 
individual floors and spaces. Each space 
has its Analytical Area, Peak Cooling Load, 
Peak Heating Load, and Calculated Air-
flow generated. Checksums are generated 
for each level to get a close estimate of the 
total Heating and Cooling Loads. These 

estimates are useful as they allow us to 
judge if these numbers fall within expect-
ed ranges for a building with this size and 
type of construction. 

Zones
Toward the middle of this report is the 

Zone information. Each zone is critical 
as it will provide information related to 

peak loads and guide us in the 
required sizing of equipment to 
serve each of these areas. 

Also, as seen in Figure 3, you 
will be provided with a break-
down of light, power, and cooling 
loads inside of each of the rooms 
which make up the zones.

Loads in the model
Going back into the model 

we’ll now have an opportunity to 
see a graphical breakdown of this 
analysis.  First, we should dupli-
cate a view so that we can apply 
a Color Scheme Legend.  Next, 
go to the Architect tab, under  
Room & Area,  and click Leg-
end. Click to place the legend 
somewhere in the view. Now se-
lect the segend and select Edit 
Scheme from the Ribbon. This 
will bring up the Edit Color 
Scheme dialog box.

From this dialog you will have 
the ability to change the color 
scheme and change the type of 

color scheme you want (Heating Loads, 
Cooling Loads, Volume, Name, Space 
type, Outdoor Air per Person, and so on). 
The areas will then take on the appropriate 
color for the information you specify (see 
Figure 4). This is a great way to check your 
spaces, systems, and your work!

Leveraging information
With our models at this stage, we can 

then either make further design decisions 
or export these designs into a third-party 
application. If we decide to export this 
data into other applications, we can also 
re-import this data back into Revit MEP 
and watch our color schemes regenerate 
appropriately to this new data. A new re-
port based on the revised data can then 
be generated to aid us in making further  
design decisions.

I believe that it is important to under-
stand the differences between communi-
cating and documenting information and 
the process of leveraging information. Revit 
MEP allows us to do both while most CAD 
programs require third-party applications. 

Of course, designs can be, and normally 
are, communicated in a traditional, paper 
deliverable, but Revit also enables design-
ers to make interactive design decisions 
and we need to find ways to incorporate 
and leverage these methods into our de-
sign processes. 

Beyond collision detection (which is 
why many companies originally adopted 
Revit MEP) we can make design decisions 
based on the information provided from 
the model and reported by our design doc-
umentation tools. Revit isn’t just a strict 
BIM tool in the definition of collecting 
information—it’s a tool that will aid and 
improve your design process as well.

Brian Myers is an applica-
tions engineer for Seiler 
Instrument in St Louis, 
Missouri. He’s been using 
Autodesk products for 20 
years in a variety of indus-
tries including residential 

and commercial design. Brian can be con-
tacted at bmyers@seilerinst.com and has a 
Twitter account at https://twitter.com/ 
BIMfacts

Figure 3: Room Information from IES report

Figure 4: Color Scheme Legend (Condition Type)
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Revit extensions: what are they, what do 
they do, and how do they help? These are 
some of the questions that we will address 
in this article. 

Revit Extensions are available to  
Autodesk Subscription Program mem-
bers only. The extension groups available 
in Autodesk® Revit® Structure 2010 are 
Import/Export, Miscellaneous, Modeling, 
Reinforcement, Robot Structural Analysis, 
Simulation, and Steel Connections.

Modeling
This extension breaks down into three 

tools—Bridge, Excel-based Model Gen-
eration, and Grids Generator. 

Bridge Extension
This is a useful module for creating 

bridges based on user-defined information. 
It should be noted that it will not verify if 
your geometry or information is correct.  

So what can you define on a bridge? You 
can define basic parameters of the geom-
etry of the bridge profile, deck, abutments, 
piers, and railings.

When you define the bridge profile you 
can pick between two types: “Arc in hori-
zontal profile” and “Parabolic vertical pro-
file.”  You can also load a LandXML file if 
you have one available to you. 

Defining the deck breaks down into two 
sections. The first is where you define the 

family and type to make up the deck and 
then its dimensions. The second section 
is Beams. Here again, you will define the 
family to be used and the type along with 
the dimensions as well as the number of 
beams with the spacing for them. 

Abutments are defined by three sets of 
parameters: Configuration, Abutment, and 
Foundation. 

Configuration allows you two options—
start abutment and end abutment, and 
then the station where it shall be located. 
The abutment and foundation sections ask 
for the family and type followed by the di-
mensions for both; refer to Figure 1.

If you have more than one span, you can 
define the piers similar to how you define 
the abutments.

Railings can be set for left, center, and/
or right. Just pick the family and type for 
each and define the dimensions for then. 

Now you’re ready to click OK and let the 
program create your bridge, complete with 
some analytical lines. Unfortunately, those 
analytical lines are currently designed for 
building modeling and require extensive 
manipulation to make them suitable for 
bridge design at this time.

The extension comes with an assort-
ment of families for all the components 
mentioned above but only enough to do 
about five different types of bridges, in-
cluding simple spans, continuous spans, 

rigid frame v-leg, rigid frame inclined leg, 
and deck plate girder, but can create more 
yourself. 

Note that a bridge longer than one mile 
cannot be done in Revit at this time. 

Excel-based Model Generation
This extension allows you to generate a 

Revit model based on data in a Microsoft 
Excel sheet. 

Revit objects that are available in the 
sheet are Levels, Columns, Beams, Walls, 
and Spread Footings. 

Two methods are offered for defining 
and/or modifying a structure model. The 
first is by entering parameters directly into 
the Excel sheet. This equals many rows on 
a sheet. The second method is by manual 
definition in a dialog used to define pa-
rameters of individual structure objects. A 
definition is performed separately for each 
object in this option.

Once you enter all the data for the Lev-
els, Columns, Beams, Walls, and Spread 
Footings, you will need to verify it using 
the tool provided for you in the extension. 
After the verification has completed, the 
generation of the model will occur. 

Grids Generator
The Grids Generator extension is used 

to define and generate levels and grids. It 
allows you to create specific types of struc-

tural elements along places on 
a grid.

There are two types of grids 
available—Cartesian (straight) 
and Cylindrical (curved). 

You can create columns, 
beams, walls, and spread foot-
ing along the grids. 

All the data to define these 
are entered through dialogs 
using parameters that later can 
be modified once the model 
has been generated, but not 
through the extension. 

There aren’t many draw-
backs, but if you have a mixed 
need for both of the grid types, 
the extension cannot be used 
for both at the same time. I 
would recommend that you 
run the extension for one type 
then again for the second type. 

Figure 1
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Reinforcement
This set of extensions is an excellent 

collection that is certain to speed up the 
productivity line in your workflow. These 
tools are designed to place rebar into  
concrete elements. 

The list is long for the number of tools 
in this extension. 

Automatic Reinforcement Generation 
lets you automatically generate reinforce-
ment for a building or selection of ele-
ments for your project. Generation occurs 

based on default values of parameters for 
each typical reinforcement concrete el-
ement based on templates or user on an 
ongoing basis in data files. 

The rest of the reinforcement extension 
all work similarly through dialogs. They in-
clude: Beams, Columns, Continuous foot-
ings, Parapets, Pile caps, Piles, Retaining 
walls, Slab corners, Slab openings, Spread 
footings, Wall corners, and Walls (see  
Figure 2).

Robot Structural 
Analysis

Four modules make up 
this extension set.

Composite Design is an 
extension for Composite 
Steel Design. Note that 
slabs and beams must be 
associated on the same 
level. The two design func-
tions here are Interactive 
and Automatic. Interac-
tive allows the user to de-
sign selected members to 
his or her own configura-
tion, check results, accept 
or make changes before 
accepting the design. Au-
tomatic allows the user to 
design members to a selec-
tion and his or her configu-
ration. The design is auto-

matic based on the user’s settings. 
Load Takedown is used to perform a 

simulation of load takedown for vertical 
forces and stresses caused by forces in ver-
tical elements of a structure. Geometry, 
material parameters, supports, loads, load 
cases, and load combinations can be load-
ed in from Revit Structure. 

Integration with Robot Structural Anal-
ysis allows for a bi-directional integration 
with Revit Structure and Autodesk Robot 
Structure Analysis.

Figure 2

Figure 3
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Reinforcement Design 
enables the design and/or 
verification of reinforced 
concrete beams and columns 
(see Figure 3).

Simulation 
This grouping is made up 

of four extensions. 
Static Analysis of Beams 

allows you to perform static 
analysis of a single or multi-
span beam. It uses informa-
tion such as beam geometry, 
constraints/supports, load 
cases, load combinations, 
and loads directly from  
Revit Structure. The results 
are displayed in two forms, 
graphically, and in a report 
that also contains the graph-
ics. The report can be printed or sent to 
Microsoft Excel or Word. It is saved in 
HTML format.

Conceptual Form Simulation is used to 
perform static analysis of a 3D solid. The 
type of information you can load from 
solids are geometer, material parameters, 
supports, loads, load cases, and loads com-
binations. Your results are presented in 
tables and diagrams.

Static Analysis of Frames performs stat-
ic analysis of a 2D frame utilizing informa-
tion from the Revit Structure model. 

Static Analysis of Trusses and Static 
Analysis of Slabs both have features similar 
to the ones mentioned above. 

Steel Connections
Two extensions are available for this 

group: Beam to column – end plate and 
Column base. 

Beam to column – end plate allows you 
to define the geometry, plate, brackets, 
bolts, stiffeners, and weld in an easy-to-use set of dialogs. You will need to pick a steel 

beam and a steel column before you run 
the extension. When the dialogs appear, 
select your options and enter your dimen-
sions, then click OK; the rest is automati-
cally created (see Figure 4).

Column base allows you to define the 
column, plate, anchorage, wedge, and 
welds in a similar fashion to the beam to 
column extension (see Figure 5).

Both of these extensions allow you to 
model the 3D connection in a snap.

On my own personal “wish list” I’d add 
the following improvement wishes. Al-
though beam to column – end plate works 
on sloped columns (raked, inclined) the 
column base does not at this time. Also, 
an extension for doing connections from 
beam to column web would complete this 
set extension.

Conclusion
All of these, and a few more extensions 

not mentioned, make your project work 
more productive and help reduce those 
production headaches. The extensions 
are easy to learn and can be self-taught 
in a small amount of time. If you are an  
Autodesk Subscription member, I highly 
encourage you to download your copy from 
the website and start using these tools! 

Robert Coutu is an appli-
cation specialist. Rob has 
worked with Autodesk Re-
vit since 1999 and with 
AutoCAD, 3ds Max, and a 
wide assortment of other 
CAD application for more 

than 18 years. He can be reached at racou-
tu@comcast.net.
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